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Creating Accessible Documents 

What is an Accessible Document? 

An accessible document is any document that has been created to be easily read by sighted, 

low-vision, or non-sighted readers using adaptive technologies. At the Children and Youth 

Planning table, we want to be sure that all the resources and information we share can be 

accessed by anyone, regardless of their ability. We require all information shared through 

Children and Youth Planning Table Communications to be accessible. Ensuring that all 

documents created and shared are accessible also ensures the content within the document is 

being conveyed in the intended manner to the reader. Non-accessible documents run the risk of 

being interpreted by adaptive technology out of order and/or without important graphic 

information – leaving the reader confused or missing information. 

This guide provides basic tips for creating accessible word documents and PDFs. 

Table of Contents 

Creating Accessible Documents ................................................................................................... 3 

Title and Table of Contents ....................................................................................................... 3 

Setting Fonts and Styles ........................................................................................................... 4 

Hyperlinks and Pasting Content ................................................................................................ 4 

Spacing ..................................................................................................................................... 4 

Inserting Tables ......................................................................................................................... 5 

Images and Figures ................................................................................................................... 6 

Creating Accessible PDF Documents ........................................................................................... 6 

Accessibility Check .................................................................................................................... 6 

Logical Reading Order and Alternate Text ................................................................................ 7 

Read Out Loud .......................................................................................................................... 9 

Checklist ..................................................................................................................................... 11 

Title and Table of Contents ..................................................................................................... 11 

Fonts and Styles ...................................................................................................................... 11 

Hyperlinks................................................................................................................................ 11 

Spacing ................................................................................................................................... 11 



  

 

Page 2 of 12 

www.childrenandyouthplanningtable.ca 

 
 

Tables ..................................................................................................................................... 11 

Images and Figures ................................................................................................................. 12 

PDF requirements ................................................................................................................... 12 

 

  



  

 

Page 3 of 12 

www.childrenandyouthplanningtable.ca 

 
 

Creating Accessible Documents 

Generally, a document is accessible if: 

 It was created using headings, subheadings, etc. 

 It contains descriptive hyperlinks. 

 Jargon has been removed.  

 The use of acronyms is limited. Ideally acronyms should be avoided, however if used, 

spell out acronyms at the first reference.  

 Sans serif fonts have been used (Click here for a list of sans serif fonts). 

 It is screen reader friendly. Free screen reader versions can be found online to test if the 

final document is screen reader friendly.  

Title and Table of Contents 

 Add a title to your document. Do this by clicking “File”, and then clicking “Info”. Locate the 

properties pane on the right-hand side. Click the fillable field beside “Title” to include the 

title of the document.  

 
 Use predefined headings to break up your document (e.g. Heading 1, Heading 2, etc.) 

 
 Use a predefined table of contents. Find this under the “References” tab, and access the 

“Table of Contents” options box by inserting a table. You many need to manually adjust 

settings to meet AODA requirements (e.g. removing italics, selecting “none” under tab 

leader, etc.) 

https://en.wikipedia.org/wiki/List_of_sans_serif_typefaces
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 Do not include critical information in the header or footer. 

Setting Fonts and Styles 

 When creating documents, use a minimum 12 point, sans serif font (e.g. Arial, Calibri, 

Verdana). 

 If you need to emphasize something, use bold font. Do not use italics, underline or all 

caps.  

 Ensure strong colour contrast and consistent font colour (ideally black) throughout the 

document. 

Hyperlinks and Pasting Content 

 When pasting text from another source, do not paste in formatting – use the “keep text 

only” option.  

 Use descriptive hyperlinks (e.g. View the Snapshot of Child and Youth Wellbeing in 

Waterloo Region report rather than click here). 

Spacing 

 Ensure line spacing between paragraphs is set at 12 point and spacing between lines is 

at 1.15. Find this under the “Page Layout” tab.  

 Avoid using “enter” to adjust line spacing. If you need additional space between lines 

and/or paragraphs for visual purposes, use the “Line Spacing Options” found in the 

paragraph section under the Home tab in Word or the “Page Layout” tab.     

 

https://childrenandyouthplanningtable.ca/wp-content/uploads/2018/03/Snapshot-of-Child-and-Youth-Wellbeing-Report-access.pdf
https://childrenandyouthplanningtable.ca/wp-content/uploads/2018/03/Snapshot-of-Child-and-Youth-Wellbeing-Report-access.pdf
https://childrenandyouthplanningtable.ca/wp-content/uploads/2018/03/Snapshot-of-Child-and-Youth-Wellbeing-Report-access.pdf
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Inserting Tables 

 Be sure to include alternative text with each table. Limit this text to 20 – 30 words (e.g. 

Table comparing the 2015 and 2016 respondents for Ontario and Waterloo Region). Do 

this by right-clicking on the table, selecting “Table Properties” and then the “Alt Text” tab. 

 
 The first row should be selected as the header row. Use “repeat header row” and do not 

break rows across the page. Access this by right-clicking on the table, and selecting 

“Table Properties” and the “Row” tab.  

 
 Do not merge, split, or leave empty cells. 

 Ensure every column has a header.  

 Do not use tables to format your document. If you need to format your document visually, 

use the headings and line spacing functions (see the Spacing section above) rather than 

using tables with empty cells and invisible lines.  
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Images and Figures 

 Each image/figure must have alternative text. This should be approximately 20 – 30 

words per image/figure. The key is to be brief, but descriptive. Do this by right-clicking on 

the image, selecting “Format Picture”, and the “alt text”.  

 
 Avoid having text as part of an image. 

 Images/figures are wrapped around text using the “tight” setting.  

 If you have images that do not need to be read by a screen reader, hide them using the 

“artifact” function (PDF).  

Creating Accessible PDF Documents  

You will need a program like Adobe Acrobat Pro to create fully accessible documents. It is easier 

to make a PDF document accessible if steps have been taken to ensure the original word 

document is accessible. Be sure to follow the above steps when creating your word document, 

prior to converting it to PDF format.  

Accessibility Check 

Start the process by completing a Full Accessibility Check. This will highlight what pieces of your 

document are not accessible.  

 Select “Tools” from the top menu. Select “Accessibility Check” and then “Full Check”. 

 Follow the instructions on the screen.   

 The check will highlight any errors, warnings or tips to improve the document in a panel 

on the left side of the screen.  
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Some errors will allow you to right click and “fix” the problem. These will usually be denoted with 

a red x. Simply select fix and follow the intructions.  

 

Some errors will require you to do manual checks. These are often the most common errors that 

results after completing an Accessibility Full Check. Both Logical Reading Order and Colour 

Contrast require manual checks. 

Logical Reading Order and Alternate Text 

The reading order of a PDF determines how a document will be real aloud with a screen reader. 

It also allows users to easily navigate through a document that is consistent with the overall 

meaning of the document. When creating a document in Word, using appropriate headings will 

help to improve the logical reading order set when converting that document to a PDF. However, 

you may still need to set or touch-up the reading order to ensure that the information is read 

aloud in a logical order. 

 Select “Touch up Reading Order” from the Accessibility drop-down menu. This will 

prompt an instructions box to appear. 
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 Select the “Show Order Panel” button to view the current reading order for each page in 

the document (along the left-hand side of the document). 

 
 All images that are decorative and/or do not contribute to the document for purposes 

outside aesthetic appeal can be tagged as “background”. To do this, right click on the 

image and select “tag as background”. 

 
 Ensure that each section of the document is tagged in the correct order (i.e. the order 

that they would be read on the page). You can do this by dragging and dropping the 

number/title listed in the order pane, on the left-hand side, into the correct order. Each 

item will also need to be tagged with the appropriate descriptor. For example, in the 

image below item 1 is tagged as “Heading 1” and item 3 is tagged as “text”. Do this by 

right-clicking the item in the order pane or the item itself and selecting the appropriate 

tag. 
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 To include items that aren’t listed in the order pane (i.e. titles or texts that are not 

selected as items) simply highlight the text, right-click and assign the appropriate tag.  

 
 All images, charts, and graphics used to convey information in the document need to 

have alternate text. If alternate text was assigned while creating the document in word, 

that text will be attributed to the image/chart/graphic when converting to a PDF. If no 

alternate text was included, add the text by right-clicking on the image and selecting “Edit 

Alternate Text”.  

 Tables will also require alternate text – known as table summaries. Right-click the table 

and select “Edit Table Summary” to include a summary of the content in a table. Table 

summaries should be a short explanation of the table’s purpose and how the content is 

organized.  

 Once the logical reading order has been set successfully, you can manually mark the 

“Logical Reading Order” result in the Accessibility Full Check as “Pass”. 

Read Out Loud 

 Confirm that the reading order has been set logically by having Acrobat Pro read the 

document out loud. To do this, click on “View” from the top menu and select the “Read 

Out Loud” option from the drop-down menu.  
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Checklist 

Have a document to share with the Children and Youth Planning Table? Use this checklist to 

ensure that your document meets accessibility requirements before submitting your 

communications request.  

Title and Table of Contents 

☐ Title added to document 

☐ Headings used 

☐  Table of contents included (where appropriate) 

☐  No critical information included in the header/footer 

Fonts and Styles 

☐  Minimum 12 point, sans serif font used 

☐  No italics, underline or all-caps  

☐  Colour contrast appropriate 

Hyperlinks 

☐  Descriptive hyperlinks used 

Spacing 

☐  Spacing between lines set at minimum 1.15 

☐  Spacing between paragraphs set at minimum 12 point 

☐  “Enter” not used to adjust line spacing (i.e. adding space between lines or paragraphs) 

Tables 

☐  All tables include alt text 

☐  No merged, split, or empty cells 
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☐  First row selected as header row 

☐  All columns have a header 

Images and Figures 

☐  All images/figures have alt text 

☐  Images/figures are wrapped around text using “tight” setting 

☐  Important text is not included as part of an image 

PDF requirements 

☐  Accessibility Check Passed 

☐  Logical reading order set 

☐  Read Out Loud manually confirmed 
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